Sage 100 Contractor 2016
(formerly Sage Master Builder)

Release Notes

Canadian and United States Editions

Version 20.2
This is a publication of Sage Software, Inc.

© 2016 The Sage Group plc or its licensors. All rights reserved. Sage, Sage logos, and Sage product and service names mentioned herein are trademarks of Sage Software, Inc. or its licensors. All other trademarks are the property of their respective owners.

Microsoft® SQL Server® and the Windows logo are either registered trademarks or trademarks of Microsoft Corporation in the United States and/or in other countries.

Your use of this document and the Sage product(s) described herein is governed by the terms and conditions of the Sage End User License Agreement (“EULA”) or other agreement that is provided with or included in the Sage product. Nothing in this document supplements, modifies or amends those terms and conditions. Except as expressly stated in those terms and conditions, the information in this document is provided by Sage “AS IS” and Sage disclaims all express, implied or statutory warranties of any kind, including but not limited to the warranties of merchantability, fitness for a particular purpose or of non-infringement. No implied license is granted to you under any Sage intellectual property or trade secret right. Sage reserves the right to revise, supplement or remove information in this document at any time without notice to you or others.

Sage End User License:  www.sage.com/us/legal/eula

Date: 7/26/2016
Contents

July 2016 Update (Build 20.2.35) .......................................................... 1

July 2016 Update (Build 20.2.30) .......................................................... 2
  U.S. Payroll Tax Tables—July 2016 Update ........................................ 2

July 2016 Update (Build 20.2.28) .......................................................... 3
  Canadian Payroll Tax Tables—July 2016 ............................................ 3
  Enhancements for U.S. and Canadian Editions .................................. 3
  Enhancements for the Canadian Edition ............................................ 3
  Fixes in the July 2016 Update ............................................................ 4

Enhancements in version 20.2 .............................................................. 6
  New Microsoft SQL Server Platform ................................................. 6
  Database Administration for Sage 100 Contractor ............................. 7
  Additional Changes for SQL Server ................................................... 9
  Other Enhancements and Changes ................................................... 9
  API for Third-Party Developer Products .......................................... 11

Installing Sage 100 Contractor 2016 .................................................... 12
  Printable checklists help you get started ......................................... 12

Migrating your company data from version 19.7 ................................. 13
  Preparing for migration in version 19.7 ........................................... 13
  Migrating reports ................................................................. 14
  Updating custom reports ......................................................... 14
  After migrating your company data .............................................. 14
  Changes to converted data ........................................................ 15
  Using Sage 100 Contractor Intelligence Reporting with Sage 100 Contractor 2016 ................................................................. 16

Known Issues and Comments ............................................................ 17
  General ................................................................. 17
Windows 7 Professional and Server 2008 R2 Standard Operating Systems .......................... 24
Windows 7 Operating System .................................................................................................. 26
July 2016 Update (Build 20.2.35)

We have fixed the following issues for both editions in this product update:

- When you copy and paste lines in subcontracts, the referenced payable invoice now applies billing to the correct line(s).

**NOTE:** During the upgrade process, Database Administration scans for any payments that were misapplied on existing subcontractor invoices because of the copy and paste issue. If it finds any, company administrators receive a message when they log in to the company in Sage 100 Contractor. Customer Support will help you to resolve this issue. For more information, see Knowledgebase article ID 77416, available at https://support.na.sage.com/selfservice/viewdocument.do?externallId=77416.

- For most users, the company list appears much more quickly after you click [Connect] in the Connect to SQL Server window.

- In very rare circumstances, opening the **3-10-4 Post T&M Invoices** window resulted in an error that closed the program. We have fixed the issue that caused this error.
July 2016 Update (Build 20.2.30)

U.S. Payroll Tax Tables—July 2016 Update

Payroll tax tables have changed for the following jurisdiction:

- Idaho
July 2016 Update (Build 20.2.28)

Canadian Payroll Tax Tables—July 2016

This section highlights federal and provincial tax changes.

Federal Payroll Tax Changes

Budget 2016 proposes to restore the Labour-Sponsored Venture Capital Corporations (LSVCC) federal tax credit to 15% for purchases of approved shares in provincially registered LSVCCs for 2016 and subsequent tax years. For more information about the tax implications of this change, visit the Canada Revenue Agency website.

For information about how this change is implemented in Sage 100 Contractor, see "Federal tax credit for LSVCCs", later in this section.

Provincial and Territorial Payroll Tax Changes

The following provinces and territories mandated payroll tax changes, effective July 1, 2016:

- British Columbia
- New Brunswick
- Newfoundland and Labrador
- Prince Edward Island

For detailed information on personal amounts, see the TD1 form for each province or territory.

Enhancements for U.S. and Canadian Editions

In the 11-2 Work Orders/Invoices/Credits window, the Phone# field on the Location tab now accepts both formatted and unformatted telephone numbers. Providing you enter a 10-digit number or a 7-digit number, Sage 100 Contractor tries to match it with a telephone number in the database, regardless of formatting, and displays the matching client on the Dispatch tab. If you enter a 7-digit number, the application tries to match the last 7 digits of a client telephone number, and displays the first client matched.

Enhancements for the Canadian Edition

Federal tax credit for LSVCCs

Starting with the 2016 budget year, employees may be eligible for a federal tax credit when they purchase shares of provincially registered Labour-Sponsored Venture Capital Corporations (LSVCCs).
You record the net cost of an employee's purchase of *provincially registered* LSVCCs in the 5-2-1 Employees window, using one of four existing boxes on the General Information tab. Sage 100 Contractor uses this amount to calculate the employee's federal tax credits when computing payroll.

**To record an employee's purchase of provincially registered LSVCCs, Sage 100 Contractor:**

1. Open the 5-2-1 Employees window.
2. Use the data control box to display the employee record.
3. On the General Information tab, in any one of the following boxes, type LSVCC: followed by the amount withheld from this employee's annual pay to purchase a provincially registered LSVCC:
   - User Def1
   - User Def2
   - Fax#
   - Pager#

Sage 100 Contractor recognizes the first amount (in the order listed above) that is preceded by "LSVCC:" as the amount eligible for the federal tax credit.

You do not need to include a thousands separator in the amount, but you must include "LSVCC:" as the initial characters in the box.

Also, you do not have to use the same field to record provincially registered LSVCC amounts for each employee.

**Federal tax credits for federally registered LSVCCs**

Federal tax credits for *federally registered* labour-sponsored funds are calculated based on the net cost you record in the Labour-Sponsored Fund box on the Compensation tab.

** Fixes in the July 2016 Update**

We have fixed a number of issues for both editions in this product update.

**Fixes for Both Editions**

- Lookup windows you open with the F5 key capture all your keystrokes even when you type search terms quickly. You do not have to navigate back to the control box to finish typing the search term.

- When you use the F9 key, the window displays the first record that matches the characters you entered in the text box.

- New general ledger accounts now appear in numerical order on Trial Balance reports.

- If you use the 2-8 Financial Reports window to print reports for more than one company, the report properly combines the account figures from the selected companies.
- Using pick lists in the 4-3-1 Invoice Selection window displays the correct invoices in the Select Invoice to Pay window, and using pick lists in the 6-6-1 Select Purchase Orders to Issue window displays the correct orders in the Purchase Order Issue Batch window.

- Reports 5-1-4-51, 5-1-4-53, 5-1-4-56, and 5-1-4-58 now display the same information as in version 19.7.

- You can delete attachments in the 6-11-3 Transmittals and the 6-11-8 Correspondence windows.

- On the Location tab in the 11-2 Work Orders/Invoices/Credits window, searching for a client by Phone# works when you type parentheses around the area code.

- In the 9-5 Takeoff window, when you update takeoff prices from the vendor, the quantities in the Vendor Price Update window match the quantities in the takeoff grid. (The quantities in the takeoff grid were correct before and remain correct after this fix.)

### Fixes for the U.S. Edition

The following issues were fixed specifically for the U.S. Edition of Sage 100 Contractor:

- The 5-1-6-31 Department of Labor and 5-1-6-36 Department of Labor reports no longer include payroll advances.

- You no longer receive an error message when you save company information for the first time and you have not selected an ACA Policy Origin Code.

- You no longer receive an error message “Unable to calculate the tax” when you save in the 12-4 Purchase Order Receipts window.
Enhancements in version 20.2

Sage is excited to introduce Sage 100 Contractor 2016 (Version 20.2), which is built on the powerful and secure Microsoft SQL Server database platform.

This section describes the new features and enhancements you will find in version 20.2.

New Microsoft SQL Server Platform

Although Sage 100 Contractor 2016 has the same look, feel, and functionality that you are familiar with, its new SQL database structure affords much tighter security and an up-to-date technology on which to build future releases. It also provides several other notable enhancements, including:

- **A new, separate Database Administration tool.** You don't have to be an expert user of Microsoft SQL Server to take advantage of its robust features! We designed Database Administration to optimize your data for Sage 100 Contractor, for example, by keeping related data in expected locations and creating backups automatically before performing certain critical processes. Many of its features are not available through SQL Server Management Studio.

  Significantly, Database Administration includes a migration utility that we have designed and tested extensively to help ensure a smooth and painless transition to SQL Server.

  We have relocated many administrative utilities and functions from the main Sage 100 Contractor program to this new tool. However, we have boosted their capabilities considerably, and now provide easily scheduled maintenance and backup functions to help you to keep your Sage 100 Contractor companies in good order.

  In addition, Database Administration offers several powerful, new capabilities that enable you to maintain tight security and exert fine control over user and program access to your SQL Server instance.

  For a comprehensive list of the utilities you will find in Database Administration, see “Database Administration for Sage 100 Contractor”, later in this document.

  **NOTE:** Database Administration comes with its own help system and a new [Database and Company Administration Guide](#) to acquaint you with its features and to guide you in its use.

- **New views for creating reports with third-party report writers.** Because the new views point to the database tables, rather than pointing your reports directly to the tables, we encourage you to use them when creating custom reports using third-party tools, such as Crystal Reports.

  For example, in earlier versions, you would point directly to actpay.vndnme to include Accounts Payable vendor names in custom reports. In the version 20.2 company database, this information resides in dbo.actpay.vndnme. However, we recommend that rather than pointing directly to the table name, you point to the field in the new view: Reports_v1.actpay.vndnme. Report views are located in the Views folder in your company database.
TIP: A compelling reason to use these views is that they may not be affected by many types of changes to the underlying tables, so future database changes will not necessarily "break" your custom reports.

Software and hardware required to support Microsoft SQL Server

Version 20.2 requires an instance of Microsoft SQL Server. You can download and use Microsoft SQL Express at no charge, or you can use the full version of Microsoft SQL Server. You can even start using Microsoft SQL Express, and upgrade to the full version of Microsoft SQL Server later, if necessary.

When you first open the new Database Administration tool, the program tries to configure an instance of Microsoft SQL Server with optimal settings for Sage 100 Contractor for you. If you do not already have an instance of Microsoft SQL Server, you can let the Database Administration tool download, install, and configure Microsoft SQL Express for you.

Refer to Knowledgebase article 67758 for detailed information about supported operating systems and software, and for minimum hardware requirements.

Database Administration for Sage 100 Contractor

The new Database Administration tool is intended for designated system administrators and company administrators. You use it to set up and maintain your company databases, and to select advanced settings to manage communications with and access to your Microsoft SQL Server instance from other programs.

If you have used earlier versions of Sage 100 Contractor, several of these tasks will be familiar to you. For example, Database Administration includes utilities for creating and deleting a company, backing up and restoring company files, and archiving company data that you used in previous Sage 100 Contractor versions.
IMPORTANT: We highly recommend that you use Database Administration, rather than SQL Management Studio®, to perform the database administration tasks listed below, even if you are an experienced SQL Server user. Besides handling all the database tasks that you are likely to perform in a typical Sage 100 Contractor system, Database Administration was designed to optimize your data for Sage 100 Contractor, for example, by keeping related data in expected locations and creating backups automatically before performing certain critical processes. In the rare event that you need to use SQL Management Studio® to perform a task that is not provided in Database Administration, you should contact Customer Support for assistance.

Database Administration includes the following database and company management utilities:

- **Create Company Based on Existing** and **Create Company** create new Microsoft SQL Server databases.
- **Rename Company** and **Delete Company** are convenient utilities when working with existing companies.
- **Deploy Sample Company** helps you install and refresh the sample data that comes with Sage 100 Contractor.
- **Tune Up Company Databases** performs various maintenance tasks to keep your database functioning efficiently.
- **Back Up Company Databases** enables you to back up your data "on demand," whenever needed.
- **Restore Company from Backup** restores a backed-up copy of your database.
- **Upgrade Company Databases** prepares your SQL company data so that it is compatible with the most recent version of Sage 100 Contractor 2016.
- **Migrate Company Data** and **Migrate Custom Reports** transfers your version 19.7 company data and custom reports to a new location for Microsoft SQL Server. Migrated files are located in shared folders under \ServerName\CompanyName, organized using a folder structure similar to earlier versions.
- **Schedule Nightly Maintenance** utilities enable you to schedule backup and maintenance operations for times when other users are not logged into the system. You can also select the number of consecutive backups to keep.
- **Manage Company Admins/SQL Logins** utilities enable you to set up or delete logins to the SQL Server database, and to designate a user as a company administrator for a specified Sage 100 Contractor company.
- **Advanced Company Settings** lets you specify how long to keep history about database changes for each company, including details about changed records, such as the date and user ID of the employee made the change. Details older than the retention period you specify are cleared during nightly maintenance. (This history is maintained in separate audit tables, which you can query using SQL Server Management Studio.)
- **Advanced SQL Server Settings** includes convenient, sophisticated access and memory management controls for your SQL database.
- **Advanced Backup Settings** lets you specify a backup folder if you prefer not to use the default folder. You can also specify the number of days to keep "on demand" backup files.
Additional Changes for SQL Server

In addition to the new SQL database platform and the Database Administration tool, you should note the following important differences from earlier versions:

- Because each user must now identify themselves to SQL Server using a unique SQL login, there is no longer a single Supervisor user. Instead, you designate as Company Administrators users who require elevated privileges in Sage 100 Contractor.

  **TIP:** You can copy supervisor preferences used in version 19.7 to individual users in the version 20.2 User List window.

- When starting Sage 100 Contractor, you first log in to an instance of SQL Server using a new Connect to SQL Server window, and then you select your company and type of access from the Company List window.

  If you need to change the type of access after logging into the company, you can return to the Company List window using the Change Company/Access link on the Sage 100 Contractor desktop.

  **NOTE:** If you want to log in as a different user, you must close Sage 100 Contractor completely first, and then log in using a different user name.

- You no longer need to reindex your data after upgrading. Now, you use the Database Administration tool to migrate your data from version 19.7 and to update it in future.

- Version 20.2 and subsequent releases are installed to a different location than version 19.7 and earlier versions.

  Having separate installation locations enables you to run version 20.2 and version 19.7 on the same computer while you migrate your data to the new version.

- You need to install the License Administration application and activate the software on the same computer as your version 19.7 license server, choosing the option to use the computer as the license server for version 20.2. After installing Sage 100 Contractor on other networked workstations, point to this machine as the license server.

  For more information, see the Installation and License Administration Guide.

Other Enhancements and Changes

More versatile Lookup windows

In version 20.2, Sage 100 Contractor provides a consistent and versatile set of enhanced Lookup windows throughout the program.

Using the new Lookup windows, you can view information and select records in convenient new ways, including:
Enhancements in version 20.2

- Choose columns to display or hide in a Lookup window.
  On the Options menu in any Lookup window, click Select Columns to Show, then select the check boxes for each column you want to display in the Lookup window, or clear the check box to hide a column from view.
- View the names associated with columns that display certain numbered records, for example, the vendor names for vendor numbers, job names for job numbers, account names for account numbers, and so on.
  Sage 100 Contractor displays name columns automatically for these numbered records, identifying them by enclosing the column heading in parentheses, for example "(Vendor Name)."

  ![NOTE: You cannot hide these name columns while the associated number column is displayed, although you can minimize the column width by dragging the right edge of the column header. If you hide a number column, the associated name column is also hidden.]

- Change the order in which columns appear in a Lookup window.
  Simply grab the column heading for a column you want to move, then drag it left or right until it is positioned where you want it to be.

  ![NOTE: If you separate a name column from its associated number column, the Lookup window does not retain the new position the next time you open the Lookup window. The name column always appears beside its associated number column when you open any Lookup window.]

- View more accurate results, and find records more quickly, when you begin typing a search term in a data control box.
  The new Lookup windows display only the records that begin with the characters you type, filtering even more effectively as you continue typing.
  When you see the record you want, select it on the list, and then press [Enter] to use it in the transaction or other window you were working with.

When you close the window, Sage 100 Contractor automatically saves your display preferences, so columns appear as you want them the next time you use Lookup features in that window.

**Simplified schedules lookup**

In the 10-3 Schedules window, you can use a new Schedules button on the toolbar to look up jobs and phases that are associated with a schedule.

When you select a job and phase in the Lookup window, the associated schedule appears in the grid in the 10-3 Schedules window.

**Unique Payroll record numbers**

In version 20.2, after you archive payroll, payroll numbers continue in sequence, rather than starting from 1, as in previous versions. The advantage is that payroll record numbers are now unique for a company, even across years.
API for Third-Party Developer Products

This release provides the following enhancements to the API:

- The API now includes the `JobCostQry` method to query the Job Cost table.
- The API now provides three new methods to determine whether a Sage 100 Contractor database has been opened exclusively, to set exclusive access, and to release a database from exclusive access.

These methods are:

- GetCompanyAvailability
- GetExclusiveAccess
- ReleaseExclusiveAccess

**NOTE:** If you submit a request for exclusive access to a company using the same instance of the API that already has exclusive access to another company, you will lose exclusive access to the other company.
Installing Sage 100 Contractor 2016

Installation of Sage 100 Contractor 2016 and upgrading your data involves a few more steps than in previous editions because you need to install two additional components. You need to:

- Install the Database Administration tool on the machine you will use as your server.
- Create a SQL Server instance for Sage 100 Contractor. This process is simplified if you use the option to download Microsoft SQL Server and create an instance automatically when you first open.

For detailed instructions on installing Sage 100 Contractor 2016, see "Chapter 3: Sage 100 Contractor Installation," in:

- The Sage 100 Contractor Installation and License Administration Guide (U.S. Edition)
- The Sage 100 Contractor Installation and License Administration Guide (Canadian Edition)

Printable checklists help you get started

Two new printable checklists are available to help you get started using Sage 100 Contractor 2016. Download them from our website, print them, and then check off each step on the printed list as you complete the necessary tasks.

- Use the Quick Start Checklist to help you stay on track when you set up your company or migrate your company from version 19.7. It provides an overview of all the important steps you should complete to install version 20.2
- Use the "Going Live" Checklist when you are ready to start using Sage 100 Contractor 2016 in a production environment (rather than a test environment). It lists all the important steps you should complete to "go live" with Sage 100 Contractor 2016.
Migrating your company data from version 19.7

**IMPORTANT:** You must be using Sage 100 Contractor version 19.7 to migrate your company to version 20.2. If you are using an earlier version of Sage 100 Contractor, you must first upgrade your company data to version 19.7.

You use the migration utility in the new Database Administration tool to automatically migrate and upgrade your data to version 20.2, including all company data in folders and subfolders of \[MB7]\[CompanyName].

Migrated files are located in shared folders under \ServerName\CompanyName. These subfolders are organized using a similar folder structure as in earlier versions, and include:

- Aatrix Forms
- Attachments
- Direct Deposit
- Images
- Reports

The Direct Deposit and Reports folders are available as soon as you open the company in Sage 100 Contractor. The remaining folders are created as needed.

**NOTE:** For detailed, step-by-step instructions on migration, see the Database and Company Administration Guide or the Database Administration help.

Preparing for migration in version 19.7

Migration should proceed smoothly in most instances. However, you should audit your accounting data and your company payroll in version 19.7, and then fix any errors, before attempting migration to version 20.2.

Use the following audit tools to prepare your data in version 19.7:

- 1-6 Period and Fiscal Year Management > Audit Books
- 5-3-7 Payroll Audit
- 6-6-3 Purchase Order Audit
- 6-7-4 Subcontract Audit
- 12-5 Inventory Audit

**NOTE:** If your data includes serious audit errors, you may need assistance from your business partner or consultant to prepare your database for migration.
Migrating reports

The new Database Administration tool also includes a utility to migrate and upgrade Sage 100 Contractor reports and reports written with the Sage 100 Contractor report designer.

In version 20.2, shared custom reports and form designs are located in these folders:

- \ServerName\Sage100Contractor\Custom Reports
- \ServerName\Sage100Contractor\Report Forms

Private custom reports and form designs are located in Sage 100 Contractor User Data folders associated with each user name, as follows:

- \ServerName\Sage100Contractor\User Data\username\Custom Reports
- \ServerName\Sage100Contractor\User Data\username\Report Forms

Updating custom reports

You also need to update custom reports created with third-party software, such as Crystal Reports, so they map to the new database.

We recommend that you use the new report views that come with version 20.2 to create or update reports. The new views were created for your convenience, so that future database changes will not necessarily break your custom reports.

After migrating your company data

After migrating your data, you will likely need to perform the following additional steps to prepare your company for use in Sage 100 Contractor:

**IMPORTANT:** Use Database Administration, not SQL Server Management Studio, for all these tasks.

- **Add company administrators.** There is no longer a generic "supervisor" user as there was in earlier versions. All users must sign into the company using their personal IDs, and only users designated as company administrators have heightened privileges previously associated with the "supervisor" role. You can designate one user as a company administrator during migration, but you can add others later.

- **Add SQL logins for new users.** If you have new users that did not exist in your version 19.7 company, add them as users to the SQL database.

  You must also add them as users and assign security in Sage 100 Contractor.
Designate an additional SQL Server administrator. Only a user with system administrator privileges for the SQL instance can administer users for SQL Server or assign the system administrator role to another user. Therefore, it is vital at all times that more than one user has a system administrator role. If the principal system administrator should suddenly fall ill, or leave your company, or otherwise be unable to perform their duties, another person with administrative access to the SQL Server database must be able to take over that role.

NOTE: The person who installs Sage 100 Contractor is automatically assigned a 'sysadmin' role in SQL Server. When they designate a SQL Server administrator in Database Administration, that person is also assigned the 'sysadmin' role in SQL Server.

Switch your Sage Construction Anywhere to version 20.2. If you have been using Sage Construction Anywhere with Sage 100 Contractor version 19.7 and want to use it with version 20.2, you will need to switch the connection to version 20.2. For help on switching the connection, see the instructions in the Installation and License Administration Guide.

Migrate your Sage ACT! settings to version 20.2. If you have been using Sage ACT! with Sage 100 Contractor version 19.7 and want to use it with version 20.2, you need to change your ACT! settings to point to your new version 20.2 company database. For help on migrating your ACT! settings to version 20.2, see the instructions in the Installation and License Administration Guide.

Migrate each user's scheduled reports from version 19.7. See the instructions in the Installation and License Administration Guide.

Migrate each user's alerts from version 19.7. See the instructions in the Installation and License Administration Guide.

Changes to converted data

During migration, the program may encounter problems that might prevent it from writing a particular record to the new SQL Server database.

If the problem is one that the migration program can fix, it repairs the record, and then writes the updated record to the SQL Server database. (For a list of the types of errors that can be fixed during migration, see the Database and Company Administration Guide.)

NOTE: Not all errors can be fixed during migration. In these cases, the record is not written to the new database.

The migration log file

The program keeps a log of all changed records and records that were not migrated because of an unresolvable error, unless the record was invalid in version 19.7. (Invalid records are neither migrated nor logged.)

After migration, you should check the log file to see what changes were made to your data during conversion, or whether any records were not migrated to the new SQL database.
The _SQL_MIGRATION_LOG.TXT file is located in the source company's main folder (for example, C:\MB7\Sample Company). A supplemental file, _SQL_MIGRATION_LOG_VERBOSE.TXT, includes more detailed information about each error found.

**Using Sage 100 Contractor Intelligence Reporting with Sage 100 Contractor 2016**

Sage 100 Contractor Intelligence Reporting version 20 is not designed to work side-by-side with version 19.7.

If you used Sage Intelligence Reporting with version 19.7, follow the steps in Knowledgebase article 75640 when upgrading to version 20.2.
Known Issues and Comments

The following sections describe known issues and problems in Sage 100 Contractor Version 20.2.

General

Internet access required for Sage 100 Contractor

Sage 100 Contractor features, such as printing or eFiling tax forms, submitting enhancement requests, accessing Help, or downloading periodic product or tax updates all require Internet access.

To take advantage of these features, ensure that any workstation or server that Sage 100 Contractor is installed on has access to the Internet.

During installation of Sage 100 Contractor, the computer serving as the Sage license server must be able to connect to the Internet to obtain licenses. Once installation is complete, you can check out license uses for each computer where Sage 100 Contractor is installed, then disconnect the Sage license server from the Internet.

NOTE: A static Internet connection using a compatible web browser is required for Sage Construction Anywhere. For current information on supported browsers, supported Sage 100 Contractor versions, and other system requirements, see the Sage Construction Anywhere help at http://help.sageconstructionanywhere.com/sage100contractor/help/Default.htm#01_Setup/System_requirements.htm.

Configuring anti-virus software and third-party firewalls

During installation of the Sage 100 Contractor Hosting Framework, the Windows Firewall is configured automatically to allow the Sage 100 Contractor Hosting Framework to act as a TCP server. If you use some other firewall, however, you may need to manually adjust some settings in the firewall in order to ensure proper operation.

You can use the following basic procedure to manually configure the Windows Firewall to allow the Sage 100 Contractor Hosting Framework to communicate with other computers. Use it as the basis for manually configuring other third-party firewall products.

To configure the Windows Firewall:

   For Windows 7, click Start > Control Panel > System and Security.
   For Windows 8.1 and Windows 10, click Start > All apps > Control Panel > System and Security.
2. Open Windows Firewall, and then select Allow a program or feature through Windows Firewall.
3. Select Sage 100 Contractor Hosting Framework on the list, if it is not selected.
NOTE: By default, the exception is set to allow access by any computer on the network. You can refine this setting by selecting the Change Scope button. Be aware that restricting the scope incorrectly can cause the computer to be unable to connect with some or all of the other machines on the network.

Files to exclude when manually configuring your firewall for Windows 8.1 Professional 32-bit

- C:\ProgramData\Sage\Sage 100 Contractor
- C:\Program Files\Sage\Sage 100 Contractor
- C:\ProgramData\Aatrix Software
- C:\Program Files\Aatrix Software
- C:\%LocalAppData%\Sage\Sage 100 Contractor
- Network location of Sage 100 Contractor data. (If you install SQL Server Express using Database Administration, this location is C:\Sage100Con\Company\.)

Files to exclude when manually configuring your firewall for Windows 8.1 Professional 64-bit

- C:\ProgramData\Sage\Sage 100 Contractor
- C:\Program Files (x86)\Sage\Sage 100 Contractor
- C:\Program Files (x86)\Aatrix Software
- C:\ProgramData\Aatrix Software
- C:\%LocalAppData%\Sage\Sage 100 Contractor
- Network location of Sage 100 Contractor data. (If you install SQL Server Express using Database Administration, this location is C:\Sage100Con\Company\.)

Files to exclude when manually configuring your firewall for Windows 7 Professional 32-bit

- C:\ProgramData\Sage\Sage 100 Contractor
- C:\Program Files\Sage\Sage 100 Contractor
- C:\ProgramData\Aatrix Software
- C:\Program Files\Aatrix Software
- C:\%LocalAppData%\Sage\Sage 100 Contractor
- Network location of Sage 100 Contractor data. (If you install SQL Server Express using Database Administration, this location is C:\Sage100Con\Company\.)

Files to exclude when manually configuring your firewall for Windows 7 Professional 64-bit

- C:\ProgramData\Sage\Sage 100 Contractor
- C:\Program Files (x86)\Sage\Sage 100 Contractor
- C:\Program Files (x86)\Aatrix Software
- C:\ProgramData\Aatrix Software
- C:;%LocalAppData%\Sage\Sage 100 Contractor
- Network location of Sage 100 Contractor data. (If you install SQL Server Express using Database Administration, this location is C:\Sage100Con\Company\.)

**Files to exclude when manually configuring your firewall for Windows 8.1 Professional**
- C:\ProgramData\Sage\Sage 100 Contractor
- C:\Program Files (x86)\Sage\Sage 100 Contractor
- C:\Program Files (x86)\Aatrix Software
- C:\ProgramData\Aatrix Software
- C:\%LocalAppData%\Sage\Sage 100 Contractor
- Network location of Sage 100 Contractor data. (If you install SQL Server Express using Database Administration, this location is C:\Sage100Con\Company\.)

**Files to exclude when manually configuring your firewall for Windows Server 2008, 2011, 2012**
- C:\ProgramData\Sage\Sage 100 Contractor
- C:\ProgramFiles (x86)\Sage\Sage 100 Contractor
- C:\Program Files (x86)\Aatrix Software
- C:\ProgramData\Aatrix Software
- C:\%LocalAppData%\Sage\Sage 100 Contractor
- Network location of Sage 100 Contractor data. (If you install SQL Server Express using Database Administration, this location is C:\Sage100Con\Company\.)

**Installation of Database Administration on a domain controller is not allowed**

SQL Server is not supported on a domain controller. If you attempt to install Database Administration on a machine used as a domain controller, you will receive an error message.

For more information see the Microsoft Knowledgebase article [https://support.microsoft.com/en-us/kb/2032911](https://support.microsoft.com/en-us/kb/2032911).

**.NET 4.5 Framework is required**

If Microsoft .NET 4.5 Framework is not already installed, it will be installed automatically when you install Sage 100 Contractor. Installation of .NET 4.5 Framework alone may take up to 20 minutes per computer.

Make sure that both your client and server computers meet the minimum requirements for installing both Sage 100 Contractor software and .NET 4.5 Framework.
**IMPORTANT:** If Sage 100 Contractor requires an installation of .NET 4.5 Framework, the Sage 100 Contractor installation process may continue automatically after the .NET Framework installation is completed. If you are prompted to restart your computer after the .NET Framework installation, you must do so to continue the Sage 100 Contractor installation.

### About network configuration and TCP Remoting Channel

Sage 100 Contractor uses the TCP Remoting Channel, a Microsoft .NET Framework component, to enable communication among computers on a network. By default, Sage 100 Contractor uses the TCP starting port 48750. Certain configurations can potentially disable the communication:

- You must enable file sharing on your computers. To enable file sharing, follow the instructions in the Windows Help.
- TCP communication requires the selection of port numbers that are not in use by other processes on the local computer.
- Software firewalls running on the local computer can be configured to block processes from opening TCP ports, which will prevent communication through the TCP Remoting Channel.

### Sage Advisor Update

Sage Advisor Update is a notification and download service that alerts you when an update is available for Sage 100 Contractor. You can use Sage Advisor Update to download and install updates available for Sage 100 Contractor and other Sage products for which you have a current Sage Business Care Plan.

**TIP:** Use the Customize settings in the Windows system tray to make sure you can view the Sage Advisor Update icon and notifications from the System Tray in your Taskbar.

For more information about Sage Advisor Update, see “About Sage Advisor Update” in the User Guide and in the Sage 100 Contractor help.

### PCI DSS Compliance

PCI DSS stands for Payment Card Industry Data Security Standard. It was developed by the major credit card companies as a guideline to help organizations that process card payments to prevent credit card fraud, cracking, and other security weaknesses and threats.

A company processing, storing, or transmitting payment card data must be PCI-compliant or risk losing its ability to process credit card payments and being audited and/or fined. (For more information about PCI standards, see https://www.pcisecuritystandards.org/.)

Sage 100 Contractor payment processing works exclusively with Sage Payment Solutions to enable merchants to seamlessly process check and credit card transactions directly in Sage 100 Contractor. The payment processing program uses Sage Exchange, a secure payment-processing application, to connect to Sage Payment Solutions and process check and credit card transactions.

Integrating your financial and operations system with Sage Payment Solutions lets you process check and credit card transactions without storing your customers’ sensitive card information in your database. Sage Exchange transmits check and credit card details through a secure connection to Sage Payment Solutions,
where they are stored in a PCI-compliant vault, protecting your from exposure to non-compliance penalties and credit card fraud.

**CAUTION:** To avoid non-compliance with PCI standards, do not store credit card information in Sage 100 Contractor. Such storage creates unnecessary risk for your business and your customers.

**Tax Forms and eFiling by Aatrix configuration requirements**

Tax Forms and eFiling by Aatrix requires an Internet connection for two reasons:

- For updating forms and executable files.
- For electronic filing (eFiling) of the forms.

If you experience an Internet connection problem, it may be due to problems communicating through an Internet firewall. Firewalls need to have access allowed through specific ports:

- The Tax Forms and eFiling Updater uses standard SSL/HTTP port 80 to access the site [http://updates.aatrix.com](http://updates.aatrix.com).
- The eFiling component uses secure HTTPS on port 443 to access the site [https://efile.aatrix.com](https://efile.aatrix.com).

By allowing access to aatrix.com, you allow both updates and eFiling. Occasionally, restrictions are tighter and only allow access to these ports by specific programs. Tax Forms and eFiling uses the following programs to access the Internet.

For updating using http on port 80 to [http://updates.aatrix.com](http://updates.aatrix.com):

- aatrixforms.exe
- updater.exe
- updater2.exe

For eFiling using secure http on port 443 to [https://efile.aatrix.com](https://efile.aatrix.com):

- builder.exe
- viewer.exe

**Printing reports at year-end (U.S. Edition)**

As of Version 19.2, in the U.S. Edition, if you pay retainage in the current year for a prior year invoice and then you print a 4 1 3 26 AP Aging report for the prior year, the report shows a reduced retainage amount, and the amount paid in the future period is allocated to the Current period or an aging period, depending on the due date of the retainage and the date it was paid.

Therefore, you should print these reports as part of your year-end processing to ensure that you have a set of reports that reflect the true amount of retainage outstanding at year end.

**TIP:** If you archive your data at year end, you can also print the reports from the archive company, later.
**Printing reports to PDF or exporting to Excel?**

When you print reports to PDF, you may find that the size of the PDF file is unexpectedly large and the resolution of the displayed PDF is not optimal.

To create a substantially smaller PDF file with good resolution, you can run Sage 100 Contractor in Compatibility Mode (compatible with Windows 7), and then print the report.

**NOTE:** You cannot export to Microsoft Excel when running Sage 100 Contractor in Compatibility Mode if you use Microsoft Office 2013.

We have not encountered this issue during testing, nor has it been reported for Windows Server 2012 R2.

**Use Adobe Reader Version 8.1.3 or later for faxing**

Customers have reported problems faxing from Sage 100 Contractor with versions of Adobe Reader earlier than 8.1.3. Adobe Reader Version 8.1.3 and later support faxing from Windows and from Sage 100 Contractor.

**IMPORTANT:** To fax from Sage 100 Contractor, the Windows Fax Service component must be installed with your Windows operating system. For more information about installing the Windows Fax Service component, see the Sage 100 Contractor Help topic, “Installing the Windows Fax Service component.”

**Sage licensing (Sage 100 Contractor Hosting Framework) cannot auto-start on Windows 8.1, Windows 7 Professional, Server 2008, or Server 2008 R2 Standard**

The Sage licensing service (Sage 100 Contractor Hosting Framework) cannot auto-start on computers running the Windows 8.1, Windows 7 Professional, Server 2008, or Server 2008 R2 Standard operating systems. If the service stops, the program displays a message advising you to take further action to resolve this issue.

**Configuring Windows Regional and Short Date Format**

To specify regional formats for Windows:

1. Click the [Start] button, point to Control Panel, then click Clock, Language, and Region.
2. Click Region and Language.
3. On the Formats tab, select the format for your country.
4. Under Date and time formats, from the Short date format drop-down list, select the format used for your country.
5. Click [OK].
6. Close the Clock, Language, and Region window.
Posting Status for a Company Created since Version 19.2

If you created a new company using version 19.2, or higher, in certain limited scenarios an issue can arise after you advance the year to the first period of the new fiscal year. The new year may not be available when you try to change the posting period.

A fix to prevent this issue is included in the January 2015 update. However, if you have already encountered this issue, contact Customer Support for assistance.

Windows 8.1 Professional and Server 2012 Standard Operating Systems

Windows 8.1 Professional and Server 2012 Standard "Sleep Mode" prevents computers from obtaining a license use

If a computer running the Windows 8.1 Professional or Server 2012 Standard operating system is used as a license server, when it goes into sleep mode other computers on the network can't obtain a license.

To avoid this possibility, set Sleep Mode on your license server computer to Never.

To set the Sleep Mode to “Never”:

2. Select Change when computer sleeps.
3. From the Put computer to sleep list, select Never.

Sage licensing (Sage 100 Contractor Hosting Framework) cannot auto-start on Windows 8.1

The Sage licensing service (Sage 100 Contractor Hosting Framework) cannot auto-start on computers running the Windows 8.1 Professional or Windows 8.1 Enterprise operating systems. If the service stops, the program displays a message advising you to take further action to resolve this issue.

Solution for Server 2012 error message about mb7.kpr file

Server 2012 network configuration and TCP Remoting Channel

Sage 100 Contractor uses the TCP Remoting Channel, a Microsoft .NET Framework component to enable communication among computers on a network. File and printer sharing on computers running the Server 2012 operating system must be enabled. To enable file sharing, follow the instructions in the Windows Server 2012 Help.
**Windows 7 Professional and Server 2008 R2 Standard Operating Systems**

**Launching Sage 100 Contractor to run as administrator for scheduling reports**

**IMPORTANT:** On computers running Windows 7 Professional or Server 2008 R2 Standard, scheduling Sage 100 Contractor reports requires that you "run as administrator" or to "run the program as administrator."

Microsoft Windows changed security rules in the Windows 7 Professional and Server 2008 R2 Standard operating systems to make your computer more secure. If you are running Sage 100 Contractor as a typical user, then you have limited privileges in some areas of the program, such as saving a report schedule. To save a report schedule, you must launch Sage 100 Contractor with the command to either **Run as administrator** or **Run this program as an administrator**.

When you select either command, the settings are limited to you personally. Your settings to run Sage 100 Contractor as administrator do not affect the next person who logs on and launches Sage 100 Contractor from this computer. Your settings on this computer can either be temporary or persistent. For example, when you select Run as administrator, you run the program as administrator for that session only. When you select **Run this program as an administrator**, you set program properties to always run the program as administrator when you log on to this computer.

**NOTE:** "Run as administrator" and "Run this program as an administrator" are not related to Windows 7 Professional or Server 2008 R2 Standard operating systems user groups but are limited to a specific program you are running.

**To set "Run as administrator":**

1. On your Windows desktop, right-click the Sage 100 Contractor program icon.
2. From the drop-down menu, to launch the program, click **Run as administrator**.

**NOTE:** Selecting **Run as administrator** only runs the current session of running Sage 100 Contractor. The setting does not persist after the session is over.

**To set "Run this program as an administrator":**

1. On your Windows desktop, right-click the Sage 100 Contractor program icon.
2. From the drop-down menu, click **Properties**.
3. On the Sage 100 Contractor Properties window, click the **Compatibility** tab.
4. Under Privileges Level, select **Run this program as an administrator**.
5. Click [Apply], and then click [OK].

**NOTE:** Selecting **Run this program as an administrator** always runs the program with these properties when you launch the program on this computer. The setting persists.
Windows 7 Professional, Windows 8.1 Professional, and Server 2008 R2 Standard "Sleep Mode" prevents computers from obtaining a license use

If a computer running the Windows 7 Professional, Windows 8.1, or Server 2008 R2 Standard operating system is used as a license server, when it goes into sleep mode, other computers on the network can’t obtain a license.

Set Sleep Mode on your license server computer to Never.

To set the Sleep Mode to “Never”:

2. Select Change when computer sleeps.
3. From the Put computer to sleep list, select Never.

Windows Server 2008 R2 and Microsoft .NET 3.5.1

Microsoft .NET 3.5.1 must be available and enabled prior to installing Sage 100 Contractor on a Windows Server 2008 R2 machine. Server 2008 R2 comes with .NET 3.5.1 loaded but not installed, so Sage 100 Contractor doesn’t install it automatically.

If you attempt to install Sage 100 Contractor without .NET 3.5.1 installed, you will receive the following message during the licensing install: “Sage.CRE.HostingFramework.Service v3.2 has stopped working.” When you click [OK], the installation continues, but the services have not been installed so Sage 100 Contractor cannot open. The Sage.CRE.HostingFramework Service will not install unless .NET 3.5.1 has been installed. If you receive the above message during installation, install .NET Framework 3.5.1 and reinstall Sage 100 Contractor.

To verify that .NET 3.5.1 is installed on Windows Server 2008 R2:

1. Click the Start button in the lower left corner of the display.
2. Highlight Administrative Tools and select Server Manager.
3. In the Server Manager interface, click Features to display all the installed Features in the right-hand pane. Verify that .NET Framework 3.5.1 is listed.

To enable .NET 3.5.1 on Windows Server 2008 R2:

1. In the Server Manager interface, select Add Features to display a list of possible features.
2. In the Select Features interface, expand .NET Framework 3.5.1 Features.
3. Once you expand .NET Framework 3.5.1 Features, you will see two check boxes. Check the box next to .NET Framework 3.5.1 and click Next.
4. In the Confirm Installation Selections interface, review the selections and then click [Install].
5. Allow the installation process to complete and then click [Close].

**NOTE:** Enabling .NET Framework 3.5.1 may require a reboot.
Solution for Server 2008 R2 "Permission Error Opening File"

If you see a permission error message when launching Sage 100 Contractor on a computer running the Windows Server 2008 R2 operating system, follow these instructions:

1. On the Window desktop, right-click Start, and then click Open Windows Explorer.
2. On the left side of the window, under Computer > Local Disk, right-click the \MB7 folder, and then select Properties.
3. On the MB7 Properties window, click the Security tab.
4. From the list under Group or User Names, select USERS, and then click the Edit button.
5. On the Permissions window, select USERS again, and under Allow, select the Full control check box.
   Selecting Full control selects all the check boxes necessary for this solution.
6. On the Permissions window, click [OK].
7. On the MB7 Properties window, click [OK].

Solution for Windows 2008 Server R2 Application Error Message

Under some circumstances, on servers operating Windows 2008 Server R2, you may see the following error message when trying to open a photograph or image file in Sage 100 Contractor:

"No application is associated with the specific file associated with this application."

This error message appears when you attempt to open an image file in Sage 100 Contractor but you have not yet enabled the Desktop Experience feature in Windows 2008 Server R2. If you receive this error message, install Desktop Experience using the Server Manager utility:

1. In Windows 2008 Server R2, select Start > All Programs > Administrative Tools > Server Manager.
2. In the Server Manager window, click Features (left-hand pane).
3. In the Features pane, click Add Features.
4. Select the Desktop Experience check box.
5. If you are prompted to add additional features, click [Add Required Features].
6. Click [Next].
7. Click [Install].

Windows 7 Operating System

Solution for Server 2008 "Permission Error Opening File"

If you see a permission error message when launching Sage 100 Contractor on a computer running the Windows Server 2008 operating system, follow these instructions:
1. On the Window desktop, right-click Start, and then click [Explore].
2. On the left side of the window, under Folders, right-click the \MB7 folder, and then select Properties.
3. On the MB7 Properties window, click the Security tab.
4. From the list under Group or User Names, select USERS, then click the [Edit] button.
5. On the Permissions window, select USERS again, and under Allow, select the Full control check box. Selecting Full control selects all the check boxes necessary for this solution.
6. On the Permissions window, click [OK], and then on the MB7 Properties window, click [OK].

**Windows 7 and changing the Sage License Server computer**

On a Windows 7 workstation, when you select File > Change Sage License Server > Select the computer from the list of computers on your network, the command may fail to generate a list of network computer names.

To resolve this issue, click Enter the IP address or name of the computer, and then type the IP address of the server computer in the box.